
Spreadsheet Assignment 2: Income Tax and Pivot Tables 

FIL 260, Trefzger 
 
Part 1: Itemize vs. Claim Standard Deduction 

Recall from the discussion of U.S. federal income taxes in our Topic 15: Home Ownership outline that households are 

permitted to subtract (“deduct”) certain expenses they incurred during the taxable year from Adjusted Gross Income in 

computing the Taxable Incomes on which their income taxes actually are paid.  Listed below are the main allowable 

deductions; note that the first three relate to home ownership:  
 
• Interest paid during the year in question on mortgage loans secured by residences (actually loans on a first and potentially 

even second home, but on debt of only up to $750,000 in total if that debt was incurred after 2017). 

• Ad valorem property tax paid to local government on one or more residences.  (What matters is when the check was 

written, not the period the tax nominally covered.  The potential deduction for Illinois residents filing their 2023 federal 

returns in early 2024 was what they physically paid in 2023, even though that would officially have been paying for public 

services received in 2022 – this income tax provision keeps things appropriately simpler, right?)    

• Income taxes paid to state or local governments.  But the combined deduction for property taxes and income taxes paid  

to state or local governments is limited to a $10,000 total each year, no matter how much in state and local taxes (SALT) 

the taxpayer actually paid. 

• Contributions to legitimate, registered “501-c-3” charitable organizations (not deductible if paid directly to needy persons). 

• Medical expenses that are not reimbursed by insurance, but only if they are high relative to income (in excess of 7.5%  

of the household’s Adjusted Gross Income, or AGI).  
 
The taxpayer is likely to put together a list of these expense items for income tax planning purposes.  However, our U.S. 

federal income tax laws have long provided an alternative to keeping this kind of detailed list and “itemizing” deductions: a 

standard deduction that any household can subtract from AGI in reaching Taxable Income without having to keep records of 

expense items, or even to have spent any money in those categories – you can never be challenged over claiming the standard 

deduction that applies to your tax filing status.  The Tax Cuts and Jobs Act passed in late 2017 greatly increased the standard 

deduction both for single individual tax filers and for married couples who file joint income tax returns (and the other filing 

status categories as well), while also removing some longstanding tax breaks built into the Internal Revenue Code.  It is 

expected that far fewer households will be itemizing deductions now that the standard deduction is so much higher than it 

used to be (now $13,850 for single individuals and $27,700 for married couples filing joint returns, for the 2023 tax year).  

But those whose expenditures in permitted deductible categories exceed the standard deduction still can pay less in U.S. 

federal income tax by itemizing.  (It is interesting that the married filing jointly standard deduction is double that for single 

filer status, but the dollar limits on items that can be itemized are largely the same for the two filing categories, meaning that 

there is a relative advantage on this dimension of federal income tax law for unmarried individuals.)                   
 
The Part 1 Assignment 

Let’s create a spreadsheet to quickly estimate whether a household should itemize.  We will look at the two most popular tax 

filing status categories: single individual and married couple filing jointly.  We will compute interest paid on identified home 

mortgage loan debt (based on tools encountered in Topic 12 – we have to assume that principal owed at this point does not 

exceed $750,000), and then will just add in presumed amounts for other potentially deductible items.  An IF statement will 

automatically limit deductible SALT expenses to $10,000.  We also will protect the sheet so someone trying to use it could 

not inadvertently erase an important formula; once the sheet is protected the user should be able to type values only into nine 

cells.  (For this fairly simple assignment it is fine to use the input numbers shown in the sample output file designed to verify 

that your formulas are right; to check your work the senior citizen instructor will enter some chosen values and see if the 

correct “itemize” or “standard deduction” messages display.)  Building the spreadsheet should be a fairly quick task, and 

while the sheet is not a perfect tool it does cover the main issues in the itemize vs. standard deduction decision.   
 
See the spreadsheet on the web site that shows all the cell formulas you will want to type in.  (It is a critical thinking exercise, 

not a typing exercise; ask yourself in each cell: what is this step doing?)   
 
 
To protect most cells while leaving open the few we need for entering numbers: first, highlight each of the cells we want to 

leave open and then right-click over the highlighted cells, choose Format Cells/Protection, un-check Locked, and click OK.  

Then under the Review menu select Protect Sheet, make sure Select Locked Cells and Select Unlocked Cells both are 

checked, and click OK.  (Various versions of Excel have different cell protection steps; you may have to fiddle with it a bit.)  

Having Select Locked Cells and Select Unlocked Cells both checked lets you maneuver more easily by moving the cursor 

into locked cells, while being able to enter values only into the cells we used the Format Cells command to keep unlocked.   

 

Cells that contain dollar amounts and percentages should be formatted accordingly, and you can take some added formatting 

steps, e.g., I used different font colors for the cells that allow for entry and the cells that show the outcomes.  But steps like 

those are not necessary for full credit if the dollar and percentage cells have appropriate formatting and the formulas provide 

correct results.   
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Part 2: Pivot Tables  

This second part of the assignment is a simple introduction to pivot tables in Microsoft Excel.®  It relates to rental residential 

real estate rather than the owner occupancy that is the subject of Topic 15, but finance students should be familiar with pivot 

tables, so combining this brief exercise with another short spreadsheet assignment makes sense.  A few years ago a small 

partnership started buying residential rental properties in Prairie County, Illinois.  Today the partners own 30 units, mostly 

single-family houses but with a small number of duplexes and condominium units in the mix.  Some data on the investments 

has been recorded in a spreadsheet that you can download from the Topic 15 section of our course web site.  Column A is 

merely numbers ranging from 1 to 30 that reflect the order in which properties were purchased, column B shows the year 

each purchase was made, column C lists the Prairie County towns where the properties are located, column D displays each 

rental unit’s type (house, duplex, condo), column E shows the prices paid, and column F contains the monthly rents collected.  

We want to create a few pivot tables to give the investors some quick summary figures (here our data set is fairly small, but 

you will see how the pivot table tool would be especially useful for generating quick summaries with very large data sets).   

 

First, put the cursor in any cell in the downloaded data table, choose the Insert tab on the ribbon at the top, and click on 

Recommended Pivot Tables.  Notice how Excel® automatically generates some summary tables, which generally would be 

helpful to these investment partners, including the total invested, total rent collected each month by property type, number  

of properties of each type, breakdown by town of price paid and monthly rent collected, and number of properties located in 

each town.  But the automated function also can generate meaningless results, such as the “sum of property” table that shows 

a condominium value of 77 (condo units were purchases numbered 8, 20, 22, and 27, which happen to sum to 77).  We can 

get more useful results by creating our own pivot tables.  [Do not submit anything in relation to the automatically generated 

tables; just briefly look at them and then close them out by hitting the X in the upper right corner.] 

 

Pivot Table 1: Amount invested each year.  Again highlight any cell in the data table, and again choose the Insert tab, but 

now click on Pivot Table.  A “Create Pivot Table” box should open, showing a Table/Range of cells A1 through F31.  (If the 

Table/Range box is blank type in A1:F31.)  Do not click on “Use an external data source” since we are using our own data, 

but do click on “Existing Worksheet” (so that the pivot table output will appear on the same sheet that contains the data).   

For Location, type in I1 and hit OK; the first pivot table created will have cell I1 as its upper left-hand boundary.  A gray box 

with the words Pivot Table Fields at the top should appear on the right-hand side of the screen.  A white box within the gray 

box should contain the column headings from the data table, and below it are four smaller white boxes labeled Filters, Rows, 

Columns, and Values.  Drag the heading Year into the Rows box, then drag Price into the Values box, and then drag Price 

into the Values box again.  (They will show as Sum of Price and Sum of Price2; Excel® will keep data table names placed in 

the Rows box but will make slight changes to data table names placed in Values.)  A table generated in cells I1 to K6 shows 

the years (column I) and the total amounts invested in each year (columns J and K).  Finally, right-click on any of the dollar 

values in Column K; a drop-down box should appear.  Hover on Show Values As and another drop box should appear to its 

right; choose % of Column Total.  Now you should have a pivot table that shows the dollar amount of property purchased 

each year and the percentage of the total investment base that was made in the indicated year, along with grand totals at the 

bottom (note that the biggest year was the third, when 49.43% of the $3,942,000 total investment dollars were committed).     

 

Pivot Table 2: Rent generated in each town.  Again highlight any cell in the data table, and again choose the Insert tab and 

click on Pivot Table.  The Create Pivot Table box should open, again showing a Table/Range of cells A1 through F31 (or 

type that range in).  Click on Existing Worksheet, and for Location type in I8 and hit OK; cell I8 will be this pivot table’s 

upper left boundary.  The gray Pivot Table Field box with the smaller white boxes again should appear on the right-hand side 

of the screen.  Drag the heading Town into the Rows box, then drag Mo. Rent into the Values box twice.  A table generated 

in cells I8 to K15 shows the towns (column I) and the total rents collected each month (columns J and K).  Finally, right-click 

on any of the dollar values in Column K; when the drop-down box appears hover on Show Values As and again choose %  

of Column Total.  Now you should have a pivot table that shows the towns where owned properties are located, the amount 

of rent collected in each of the towns each month, and the percentage of the rent total generated in the indicated town, along 

with the grand totals (25.61% of the $39,755 in total monthly revenue is collected in Eastview; Hillsdale yields only 8.55%). 

 

Creating a graph from a pivot table.  Move the cursor to any cell in the pivot table just created (cells I8 to K15).  Select 

Insert on the ribbon at the top and choose Pivot Chart (in the middle at the top of the page).  Double-click on the Clustered 

Column or Stacked Column format and click on OK; a bar chart will appear on our worksheet page that contains the data and 

the two pivot tables already produced.  This graph shows how much monthly rent is collected on rental units in each of the 

six towns where purchases have been made.  Click on the circle at the lower-right corner of the graph, and drag upward and 

to the left to make the graph smaller, perhaps with a height about equal to that of the second pivot table.  Then place the 

cursor somewhere inside the reduced graph and drag the entire figure into the area just to the right of the second pivot table.  

It is easy to see on the chart that the greatest portion of the partners’ rent revenue comes from Eastview and the lowest share 

from Hillsdale.  
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Pivot Table 3: Breakdown by town and property type.  Now we will create a somewhat more detailed pivot table.  Again 

highlight any cell in the data table, choose the Insert tab, click on Pivot Table, make sure the A1 to F31 range shows, click on 

Existing Worksheet, and for Location type I17 and hit OK; the output will start in cell I17.  In the Pivot Table Field box drag 

Town into the Rows box, then drag Type into Rows just below Town.  Then drag Price into the Values box twice, and then 

drag Mo. Rent into Values twice.  A table generated in cells I17 to M37 shows the towns and the property types within each 

town (column I), the total amounts invested by town and property type (column J and repeated in column K), and the total 

rent collected each month by town and property type (column L and repeated in column M).  Right-click on any dollar value 

in Column K; when the drop box appears hover on Show Values As and again choose % of Column Total.  Then repeat that 

process in Column M.  This pivot table shows for each town, and then in more detail by property type within the town, the 

amount invested, percentage of the total investment base, amount of rent collected per month, and indicated percentage of the 

total rent rolls.  The partners might note from a diversification perspective that houses in Newtown account for only 2.23% of 

the dollars invested.  Or from the standpoint of revenues generated relative to money invested they might note that Midville 

accounts for 16.13% of the portfolio’s cost but a much higher 19.37% of rents generated, with duplexes in that jurisdiction 

accounting for 11.72% of the investment base but a much higher 13.96% of the total monthly rent revenues.  Westwood, on 

the other hand, accounts for a high 20.56% of money invested but only 17.62% of monthly revenues; corresponding figures 

for houses in that community are 15.16% and 12.78%.  Possible future purchases in Westwood might merit special caution.  

(Of course rent revenue is just the top line of the partners’ income statement; a more in-depth analysis than we are doing here 

might disclose that towns with revenues that are high relative to prices paid also have higher proportional operating costs, 

perhaps property taxes are higher, such that the profitability of investments in those communities is not actually greater.)      

 

Improving the format: Now that the three main desired pivot tables have been generated they can be formatted the way we 

format anything in Excel.®  Highlight cells J1 to M37 (the graph being in the way should not cause any problems), and then 

choose the Home tab and the centering icon to horizontally center the contents of those cells.  Then while holding down the 

Ctrl key highlight cells J2-J6, J9-J15, J18-J37, and L18-L37; right-click, and choose Format Cells and Currency (no decimal 

places) to show all money amounts as dollars.  Then re-label the top line of each pivot table, perhaps as Year/Investment/% 

of Total Inv in pivot table 1, Town/Rent/% of Total Rent in pivot table 2, and Town/Investment/% of Total Inv/Rent/% of 

Total Rent in pivot table 3.  Finally, if the cursor is in any cell of a created pivot table the ribbon at the top should show a 

Design tab at the far right.  Clicking that tab allows many choices on shading and font colors; choose any combinations you 

like for the three pivot tables already completed and the fourth that we are about to create.   

 

Pivot Table 4: Zeroing in on the most significant towns.  A pivot table can be modified for a focus on specific features.  

Highlight all of cells I17 to M37, hit Ctrl-C (for Copy), move the cursor to cell I39, and hit Ctrl-V (to Paste).  A copy of the 

third pivot table now should appear in cells I39 to M59.  Cell I39 should show Town and a box with a down arrow; click on 

the arrow and a drop-down box should appear.  Hover on Value Filters and another drop box should appear at the right; click 

on Top 10 at the bottom.  Another box with four sub-boxes appears; in the second sub-box replace 10 with 3 and click OK 

(we want to look at the three towns that account for the highest investment values represented in the data table).  The result 

should be an abbreviated and recomputed pivot table, appearing in cells I39 to M50, showing results for only Eastview, 

Sussex, and Westwood.  Percentage values are recomputed as though all of the rental units were in these three locales.   

Now we see that Eastview accounts for the highest share of invested dollars among the three largest areas and generates an 

even higher proportion of revenues (true across all three property types), while Sussex’s percentages of dollars invested and 

revenues generated are approximately equal, and Westwood again shows weak revenues relative to money invested, in total 

and also for both condo units and houses individually. 

 

What to Submit for Spreadsheet Assignment 2 

Create one Excel® workbook file with two worksheet pages: one for part 1 results and one for part 2 results.  Submit an 

Excel® file, not pdf’s, because as noted the instructor will check your part 1 work by changing values in various input cells.  

For part 2 do not change any of the numbers; simply submit the worksheet that contains the downloaded data and the four 

pivot tables (and one pivot chart) you created with that data, as discussed in the paragraphs above.  Files showing what the 

part 1 and party 2 output should look like are on the course web site.  Upload your submission to Reggie Net if you can; 

attach it to an e-mail to the instructor if you can not.  You are to do your own individual work; our spreadsheet homework 

assignments are not group projects (you are bound by the ISU honor code even if you do not upload your completed work  

to Reggie Net, where you are required to check the honor code box before submitting).  Call (309-438-2966) or e-mail 

(trefzger@ilstu.edu) with questions.  Due date and time are shown with the assignment on Canvas.  ▪   
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